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Notice

All information included in this document is current as of the date this document is issued. Such information, however, is
subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please
confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful attention to
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website.

Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights
of Renesas Electronics or others.

Y ou should not ater, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of
semiconductor products and application examples. You are fully responsible for the incorporation of these circuits, software,
and information in the design of your equipment. Renesas Electronics assumes no responsibility for any losses incurred by
you or third parties arising from the use of these circuits, software, or information.

When exporting the products or technology described in this document, you should comply with the applicable export control
laws and regulations and follow the procedures required by such laws and regulations. Y ou should not use Renesas
Electronics products or the technology described in this document for any purpose relating to military applications or use by
the military, including but not limited to the development of weapons of mass destruction. Renesas Electronics products and
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited
under any applicable domestic or foreign laws or regulations.

Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics
does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever for any damages
incurred by you resulting from errorsin or omissions from the information included herein.

Renesas Electronics products are classified according to the following three quality grades: “Standard”, “High Quality”, and
“Specific’. The recommended applications for each Renesas Electronics product depends on the product’ s quality grade, as
indicated below. Y ou must check the quality grade of each Renesas Electronics product before using it in a particular
application. You may not use any Renesas Electronics product for any application categorized as “ Specific” without the prior
written consent of Renesas Electronics. Further, you may not use any Renesas Electronics product for any application for
which it is not intended without the prior written consent of Renesas Electronics. Renesas Electronics shall not be in any way
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an
application categorized as “ Specific” or for which the product is not intended where you have failed to obtain the prior written
consent of Renesas Electronics. The quality grade of each Renesas Electronics product is“ Standard” unless otherwise
expressly specified in a Renesas Electronics data sheets or data books, etc.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual
equipment; home el ectronic appliances; machine tools; personal electronic equipment; and industrial robots.

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support.

“Specific”: Aircraft; aerospace equipment; submersible repesaters; nuclear reactor control systems; medical equipment or
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or healthcare
intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life.

Y ou should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics,
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or
damages arising out of the use of Renesas Electronics products beyond such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further,
Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire
control and mal function prevention, appropriate treatment for aging degradation or any other appropriate measures. Because
the evaluation of microcomputer software aloneis very difficult, please evaluate the safety of the final products or system
manufactured by you.

Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with al applicable
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS
Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with
applicable laws and regulations.

This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas
Electronics.

Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “RenesasElectronics’ asused in this document means Renesas Electronics Corporation and also includes its majority-

owned subsidiaries.

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.




NOTES FOR CMOS DEVICES

(1) VOLTAGE APPLICATION WAVEFORM AT INPUT PIN: Waveform distortion due to input noise or a
reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL
(MAX) and VIH (MIN) due to noise, etc., the device may malfunction. Take care to prevent chattering noise
from entering the device when the input level is fixed, and also in the transition period when the input level
passes through the area between VIL (MAX) and VIH (MIN).

(2) HANDLING OF UNUSED INPUT PINS: Unconnected CMOS device inputs can be cause of malfunction. If
an input pin is unconnected, it is possible that an internal input level may be generated due to noise, etc.,
causing malfunction. CMOS devices behave differently than Bipolar or NMOS devices. Input levels of
CMOS devices must be fixed high or low by using pull-up or pull-down circuitry. Each unused pin should be
connected to VDD or GND via a resistor if there is a possibility that it will be an output pin.  All handling
related to unused pins must be judged separately for each device and according to related specifications
governing the device.

(3) PRECAUTION AGAINST ESD: A strong electric field, when exposed to a MOS device, can cause
destruction of the gate oxide and ultimately degrade the device operation. Steps must be taken to stop
generation of static electricity as much as possible, and quickly dissipate it when it has occurred.
Environmental control must be adequate. When it is dry, a humidifier should be used. It is recommended
to avoid using insulators that easily build up static electricity. Semiconductor devices must be stored and
transported in an anti-static container, static shielding bag or conductive material. All test and measurement
tools including work benches and floors should be grounded. The operator should be grounded using a wrist
strap. Semiconductor devices must not be touched with bare hands. Similar precautions need to be taken
for PW boards with mounted semiconductor devices.

(4) STATUS BEFORE INITIALIZATION: Power-on does not necessarily define the initial status of a MOS
device. Immediately after the power source is turned ON, devices with reset functions have not yet been
initialized. Hence, power-on does not guarantee output pin levels, I/O settings or contents of registers. A
device is not initialized until the reset signal is received. A reset operation must be executed immediately
after power-on for devices with reset functions.

(5) POWER ON/OFF SEQUENCE: In the case of a device that uses different power supplies for the internal
operation and external interface, as a rule, switch on the external power supply after switching on the internal
power supply. When switching the power supply off, as a rule, switch off the external power supply and then
the internal power supply. Use of the reverse power on/off sequences may result in the application of an
overvoltage to the internal elements of the device, causing malfunction and degradation of internal elements
due to the passage of an abnormal current. The correct power on/off sequence must be judged separately
for each device and according to related specifications governing the device.

(6) INPUT OF SIGNAL DURING POWER OFF STATE : Do not input signals or an 1/O pull-up power supply
while the device is not powered. The current injection that results from input of such a signal or I/O pull-up
power supply may cause malfunction and the abnormal current that passes in the device at this time may
cause degradation of internal elements. Input of signals during the power off state must be judged
separately for each device and according to related specifications governing the device.
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Preface
This manual is intended for users who want to understand the functions of the
concerned microcontrollers.
This manual presents the hardware manual for the concerned microcontrollers.

This system specification describes the following sections:

e Introduction e How to use WriteEZ5 flash
programming software

e System configuration o Applilet EZ for HCD controller

e Board components e Troubleshooting

e Getting started e Schematics

e Hardware installation o Bill of materials

e Software installation

These microcontrollers may contain several instances of a dedicated module.
In general the different instances of such modules are identified by the index “n”,
where “n” counts from 0 to the number of instances minus one.

Symbols and notation are used as follows:

e Weight in data notation: Left is high order column, right is low order

column

e Active low notation: xxx (pin or signal name is over-scored) or
Ixxx (slash before signal name) or
_ XXX

e Memory map address: High order at high stage and low order at
low stage

Additional remark or tip

Item deserving extra attention

Binary: XXXX Or XxxB

Decimal: XXXX

Hexadecimal XXXXH or 0X XXXX

Representing powers of 2 (address space, memory capacity):

K (kilo): 2'°=1024
M (mega): 2%° = 10242 = 1,048,576
G (giga): 2%0 = 10243 = 1,073,741,824

X, x = don’t care

Block diagrams do not necessarily show the exact wiring in hardware but the
functional structure. Timing diagrams are for functional explanation purposes only,
without any relevance to the real hardware implementation.



Safety Precautions

This document describes items to be observed to ensure the safe use of this evaluation board. Be sure to

read this document before using the board.

Symbols Used

This document uses the following symbols for items to be observed to ensure the safe use of the unit.
The symbols are followed by a brief explanation of the possible extent of problems which may occur if the

items are not observed.

The risk is high if the warning is not
observed, and the user may suffer death
or serious injury.

The user may suffer death or serious
injury if the warning is not observed.

Human injury or property damage may
occur if the caution is not observed.

The following symbols express behaviors that are prohibited in order to prevent injury or accident.

General prohibition

The action mentioned
is prohibited.

Do not touch

Touching the specified
location may cause

Do not disassemble

Disassembly may
cause a problem such

injury. as electric shock or
product failure.
Keep away from Flammable Do not touch with wet

water

NG Use near water poses
N the risk of electric

shock or product
failure if moisture were
to contact the unit.

v

Proximity to flame

may cause the unit to ||u
catch fire. ‘:

hands

Touching with wet
hands may cause
electric shock or
product failure.

The following symbols are used for cautions to prevent product failure and accidents.

General caution
Unspecified general cautions

>

Caution: Hot
Human injury due to a high temperature

The following symbols are used for instructions to prevent product failure and accidents.

Action required of the user

Instruction to unplug from AC power
supply




Warnings

A Warning
Be careful to avoid burns.

The temperature of this part of board increases when AC power is connected.

Be careful of LED brightness and the LED On/Off interval.
Simulations of strong light may cause symptoms linked to an epileptic condition.

Do not use this board for a purpose other than the evaluation of an MCU.

This board does not include the safety measures or anti-EMI measures required for lighting
equipment.

Do not heat the board or expose it to fire and do not short the terminals.
Doing so may cause the product to fail, heat up, catch fire, or rupture.

Do not disassemble or modify the board.
Doing so may cause the product to fail, emit smoke, or catch fire, or result in electric shock.

?® B> PP

Do not touch with wet hands.
Doing so while connected to power may cause the product to fail or result in electric shock.

%,

Do not look directly at the LEDs on this board.
Doing so may weaken eyesight.

Do not drop the board or subject the board to heavy impact.
Doing so may break or damage the board, causing fire or electric shock.

Do not turn on the power switch when the AC adapter, interface cable, or other cables are
not properly connected.

Doing so may cause the product to fail, heat up, or catch fire, or result in electric shock.

Do not plug in or unplug a connector or cable with power applied to the board.
Doing so may cause the product to fail, heat up, or catch fire, or result in electric shock.

Do not move this board when the AC adapter or any cables are connected.

Doing so may damage cables and cause the product to fail, heat up, or catch fire, or result in
electric shock.

Use this board with a spacer and on an electrically isolated bench.

If a conductor contacts the board, the product may fail, heat up, or catch fire, or it may result in
electric shock.

Use an AC adapter adapted to the safety standard of each country.

Using an inappropriate AC adapter may cause the product to fail, heat up, or catch fire, or result
in electric shock.

Use the specified AC adapter.

Using an AC adapter other than that specified may cause the product to fail, heat up, or catch
fire, or result in electric shock.

Use an AC adapter of the following size and DC plug polarity. @'_C :
EIAJ Type2 Plug (outer diameter: 4.0 mm, inner diameter: 1.7 mm)

Using another type of AC adapter may cause the product to fail, heat up, or catch fire, or result in
electric shock.

Confirm that the outlet is near this board and can be easily unplugged.




/\ Warning

-2

If smoke or an abnormal smell or sound is emitted or if overheating occurs, promptly
switch off the board power and unplug the AC power supply.

Using the board in such a state poses a risk of fire, burning or electric shock.

Cautions

A Caution

Do not use or store this board in any of the following locations.

- Environments with excessive water, humidity, steam, dust, fume, etc.

- Environments where static electricity or electrical noise is readily generated.
Such influences can lead to electric shock or product failure.

If liquid enters the board, disconnect the power supply, and consult your dealer or Renesas
Electronics sales representative.

Even if the unit appears to be dry, internal moisture may remain.

Do not directly touch LEDs on this board.
Doing so may cause product failure.

To prevent static electricity damage, guard against static discharge when touching metal
parts such as the connector.

Static electricity can cause product failure.




Overview

This board is used to evaluate LED control by the RL78/11A microcontroller.

This board can operate with the 5 VDC power supply provided by an AC adapter, which should be
prepared separately.

By using the Lighting Communication Master Evaluation Board (EZ-0008) and a GUI tool (which can be
downloaded from the Renesas Electronics’ website), dimming evaluation by DALI, DMX512 or infrared
data communication protocol is possible.

Ol AC adapter
(Please prepare by yourself)

DMX512 |

diid)

EZ-0008

This board
(EZ-LED4-0002)

*Prepare an AC adapter that satisfies the following:
- Output voltage: 5VDC
- Output current:  >2 A
- Type: Switching regulator type with overcurrent protection circuit

Do not use an AC adapter whose output voltage is guaranteed only when
the rated load current flows.

- Connector plug: EIAJ-2 (outer diameter: 4.0 mm, inner diameter: 1.7 mm)

o0

A Warning

0 Use an AC adapter that conforms to the safety standard of each country.

Using an incorrect AC adapter causes the product to fail, heat up, or catch fire, or result in electric
shock.




Appearance of the board

Surface appearance (top view)

Analog volume switch

DC plug
for AC adaptor

Connector for
DMX512

USB connector

Surface appearance (back view)

L LTI
SO0 ROA A

High brightness LED

Be careful to avoid burns.
Parts of the board, especially the area enclosed by a dotted line, become extremely hot.

Doing so may weaken eyesight.
Use this board with the LED mounting surface back.

Use a specified AC adapter.

Using an AC adapter other than that specified causes the product to fail, heat up, or catch fire, or
electric shock.

® Do not look directly at LEDs on this board.




A Caution

Do not touch directly LEDs on this board.
Doing so may cause a product failure.

For usage of this board, see the User’'s Manual. The User's Manual can be downloaded from the following
webpage.

URL: http://tool-support.renesas.com/eng/toolnews/download/exel/solution_lighting.html
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Chapter 1 Introduction

The RL78/I1A DC/DC LED Control Evaluation Board is an evaluation board for
the new Renesas RL78/I1A microcontroller. It supports On-Board debugging,
flash programming, and is intended to demonstrate the RL78/I1A MCU'’s special
features dedicated to LED lighting system control.

1.1 Main features of RL78/I11A DC/DC LED Control
Evaluation Board

e LED lighting system control demonstration capabilities

e RL78/I1A DC/DC LED Control Evaluation Board features circuits to perform
constant current control of 3 LED channels (RGB LEDs) in order to
demonstrate the special 16-bit Timers KBn (n =0, 1, 2).
o Buck topology
o 350 mA maximum current per channel

e 4 types of dimming control interface supported
o 3 ch. analog volume control interface (for standalone evaluation)
o DALI protocol communication interface
o DMX512 protocol communication interface
o IR remote control interface

e Easy to use device demonstration capabilities
RL78/I11A DC/DC LED Control Evaluation Board contains elements to easily
demonstrate simple 1/O-functions (i.e. LED output, I/O lines, UART serial
interface) together with the other key functions such as Real Time Clock (RTC),
ADC and Timers.

e Power supply via 5V DC connector
RL78/11A DC/DC LED Control Evaluation Board is powered via a 5V DC jack
connector. This power supply is used to power the RL78/I11A as well as the LEDs.
When On-Board debug function is used, the USB interface is used to power the
pPD78F7030 78K0 USB microcontroller.

e On-Board debug function
RL78/11A DC/DC LED Control Evaluation Board supports an On-Board debug
function by using the CubeSuite+ IDE, without the need of additional debug
hardware. It allows flash programming and supports standard debug functions
such as code execution, single stepping, software breakpoints, memory
manipulation etc. (The E1 emulator can also be used for on-chip debugging)

o WriteEZ5, Flash programming software
Windows based Flash programming software allows the user to select and
download application programs to the RL78//1A DC/DC LED Control Evaluation
Board for evaluation purposes via USB.

o Applilet EZ for HCD Controller, Automated software generation tool
Software tool used to generate full projects for different compilers.

e Various input / output signals available, such as
° Al /O ports prepared to be connected to user hardware
° Virtual UART interface, via the yPD78F0730 78K0 8-bit microcontroller
with on-board USB interface

R20UT2028EJ0100 Rev. 1.00 NS 1
March 23, 2012 RENES



RL78/11A Chapter 1 Introduction

e The CubeSuite+ Integrated Development Environment (IDE) supports the
RL78/11A devices. This package is not restricted in program code size.

e Full documentation is included for the Renesas software tools and the RL78/[1A
device.

1.2 System requirements

HOST PC A PC supporting Windows XP, Windows Vista or 7 is required for the
development tools installation. A Pentium processor with at least 1 GHz
CPU performance, with at least 256 Mbytes of RAM, allowing you to fully
utilize and take advantage of the product features.
350 Mbytes of free disk space and an additional 10 Mbytes of free disk
space on the Windows system drive.

A web browser and Adobe Acrobat Reader to be able to access all the
product documentation.

Host interface USB interface that enables communication based on USB (Ver1.1 or later)

1.3 Package contents

e RIL78/1A DC/DC LED Control Evaluation Board
e USB Type A/ Mini-B cable
e Connection wires for DMX512 and DALI connectors

If any part is missing or seems to be damaged, please contact the dealer from
whom you received your RL78/I1A DC/DC LED Control Evaluation Board.

R20UT2028EJ0100 Rev. 1.00 NS 2
March 23, 2012 RENES
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Chapter 2 System Configuration

Figure 1:

2.1

2.2

2.3

The RL78/I1A DC/DC LED Control Evaluation Board system configuration is
given in the diagram below:

RL78/I11A DC/DC LED Control Evaluation Board System Configuration

RL78/I1A DC/DC LED Control Evaluation Board

RL78/I11A DC/DC LED Control Evaluation Board is a demonstration board for
evaluating the new Renesas RL78/I1A family of devices. The device used is the
RL78/I11A (R5F107DEG). The board can be directly connected to the host system
via a USB port. The host system may be used for On-Board debugging or Flash
programming and to allow execution of the Demonstration program on the
RL78/I1A device.

As default, the RL78/I11A is using the 32 MHz internal high-speed oscillator, but
the RL78/I1A DC/DC LED Control Evaluation Board is provided with a connection
for an external 20 MHz oscillator (not fitted) if the user wishes to use a different
clock frequency than that provided by the internal high speed oscillator. An
external low power 32.768 KHz resonator is provided for the sub-clock.

Host Computer

The USB host interface enables communication to the RL78/I11A DC/DC LED
Control Evaluation Board. The yPD78F0730 78K0 8-bit microcontroller with on-
chip USB interface and the Renesas Electronics virtual UART driver allows
application software to access the USB device in the same way as it would
access a standard RS232 interface. The Renesas Electronics virtual UART driver
appears to the windows system as an extra Com Port, in addition to any existing
hardware Com Ports.

Power Supply

RL78/I1A DC/DC LED Control Evaluation Board is powered by a 5V DC power
supply and also by USB interface when the yPD78F0730 78K0 microcontroller is
to be used for On-Board debugging, flash programming or virtual UART
communication purpose.

R20UT2028EJ0100 Rev. 1.00 RENESAS 3
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Chapter 3 Board Components

The RL78/I1A DC/DC LED Control Evaluation Board is equipped with a USB
connector and with several connectors in order to be connected to host
computers, E1 emulator, DALI or DMX master or any external target hardware.

SW501 SW1 U2 VR1 VR2

VR3

CN1 e ':* :l
L 5
. ;:
4 SW2
CN2 - : HE I—
LI & ol i
.=£ :
- -
- J3
CN3 Y1
Ja
CN501

Figure 2: RL78/11A DC/DC LED Control Evaluation Board Components

Some of the RL78/I1A DC/DC LED Control Evaluation Board components are free
for user application hardware and software. Please read the User's Manual of the
RL78/11A device carefully to get information about the electrical specification of the
available I/0 ports before you connect any external signal to the RL78//1A DC/DC
LED Control Evaluation Board.

3.1 Configuration Switch SW2

The switch SW2 controls the different operating modes of the RL78/[1A DC/DC
LED Control Evaluation Board.

3.1.1 Normal Operation Mode

The default operation of the board is set for Normal Operation mode. Switch SW2
should be set as shown in the table below:

1* OFF
2" OFF
3 OFF
4 OFF
5 OFF
6 OFF
7 ON
8 ON

Table 1: SW2, Normal Operation Mode

*When DALI or DMX512 communication is to be used, bits 1 and 2 of switch SW2
should both be set to ON position.

R20UT2028EJ0100 Rev. 1.00 NS 4
March 23, 2012 RENES
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3.1.2 On-Board Debug (OCD) Mode / Flash Programming Mode

The RL78/I1A DC/DC LED Control Evaluation Board supports on-board debug
mode via the USB interface achieved by a dedicated monitor running on the
RL78/11A device. By using the CubeSuite+ debugger, flash programming and
standard debug functions i.e. code execution, single stepping, software
breakpoints, memory manipulation etc. are supported.

Additionally the built-in Flash memory of the RL78/I1A device can be re-
programmed by using the WriteEZ5 Flash programming GUI.

Configure switch SW2 as following to use the on-board debug or Flash
programming mode:

Bits Configuration
1* OFF
2* OFF
ON
OFF
ON
OFF
ON
OFF

oo N[O~ (W

Table 2: SW2, On-Board Debug / Flash Programming Mode

* When DALI or DMX512 communication is to be used, bits 1 and 2 of switch
SW2 should both be set to ON position.

3.1.3 E1 On-Chip Debug Mode

The RL78/I1A DC/DC LED Control Evaluation Board also supports on-chip
debug mode via the E1 emulator. When using the E1 emulator for on-chip

debugging, the board can either be powered from the emulator or from the 5V
DC power supply.

Bits Configuration
1* OFF

2* OFF

OFF

OFF

OFF

OFF

ON

ON

PN~ |W

Table 3: SW2, E1 On-Chip Debug Mode

*When DALI or DMX512 communication is to be used, bits 1 and 2 of switch
SW2 should both be set to ON position.

R20UT2028EJ0100 Rev. 1.00
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3.1.4 Virtual UART Mode

The RL78/I11A DC/DC LED Control Evaluation Board supports Virtual UART mode
via the yPD78F0730 78K0 8-bit microcontroller. Switch SW2 should be set as
shown in the table below:

1* OFF
2" OFF
3 OFF
4 ON
5
6
7
8

OFF
ON
ON
ON

Table 4: SW2, Virtual UART Mode

*When DALI or DMX512 communication is to be used, bits 1 and 2 of switch SW2
should both be set to ON position.

3.2 Configuration Switch SW1

The switch SW1 selects the lighting communication protocol to be used by the
RL78/11A DC/DC LED Control Evaluation Board.

When using DALI or DMX512 communication, please don’t forget to set bits 1
and 2 of switch SW2 to ON position.

1-2&4-5 DALI
3-2 & 6-5 DMX512

Table 5: SWH1, Lighting Communication Protocol Selection

3.3 Configuration Switch SW3

The switch SW3 selects the IR remote control channel. Two different channels
can be selected on the RL78/I1A DC/DC LED Control Evaluation Board, CH1
corresponds to a 0x5AA5 data code, and CH2 to a 0xDA25 data code.

CH1 Custom code: 0x0000+Data code: 0x5AA5
CH2 Custom code: 0x0000+Data code: 0xDA25

Table 6: SW3, IR Remote Control Channel Selection

R20UT2028EJ0100 Rev. 1.00 NS 6
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3.4

3.5

3.6

3.7

3.8

Reset Switch SW501

The switch SW501 is the reset switch of the RL78/I1A DC/DC LED Control
Evaluation Board. It can be used to reset operation during on-board debugging or
during normal operation mode.

External Power Supply CN1

External power is supplied by connecting a regulated 5V DC to the jack
connector CN1.

The operation of the board is as follows:

- External supply only (The board can only be operated as stand alone only, no
USB power connection).

Or

- External supply and USB power (This configuration should be used when the
user intends to use On-Board debugging, flash programming or virtual UART
communication via the yPD78F0730 78KO0 8-bit microcontroller).

DALI Interface Connector CN2

CN2 is the connector for DALI interface. CN2 is a 2-way connector to enable
communication with a DALI master via the DALI communication protocol.

DMX512 Interface Connector CN3

CN3 is the connector for DMX512 interface. CN3 is a 3-way connector to enable
communication with a DMX512 master via the DMX512 communication protocol.

InfraRed Detector U2

InfraRed (IR) detector U2 can be used to enable IR communication between a
controller device and the RL78/I1A. The controller device can send commands to
the RL78/I1A microcontroller using the IR communication protocol.

March 23, 2012
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3.9 E1 Emulator Connector J4

Connector J4 (not fitted) is provided to allow debugging and programming of the
RL78/I1A microcontroller using the E1 OCD emulator. This function allows the user
to be able to debug an application and make use of the UARTO serial interface that
can use the Renesas Virtual UART to interface to the PC. For this function a 14-
way (2 x 7) standard pitch connector needs to be mounted and connected as

shown below.
VDD J5 VDD
»—1 TcK GND |2 T
TooLo TRST  EMLE M= |RedeT
—3 1po NC -2
—I MD1 vec (- =
™S MDO (=12
rsT i DI GND -2
—=——13 1 RES GND
E1 connector (unmounted) =
El Interface Co&nector

Figure 3: E1 Emulator Connection

3.10 Programming Connector J3

Connector J3 is provided for production programming of the yPD78F0730 78KO0 8-
bit microcontroller during manufacturing. The 78K0/USB device should not be
reprogrammed.

3.11 Mini-B USB Interface Connector CN501

The mini-B USB connector allows connecting the CubeSuite+ IDE or the WriteEZ5
Flash programming software to the RL78/[1A DC/DC LED Control Evaluation
Board in order to debug or program application software to the RL78/I1A device.
The power supply for the 78K0/USB device is also provided by this connector.

Additionally connector CN501 connects the UARTO serial interface of the RL78/11A
device to the host system.

Figure 4: Connector CN501, Mini USB B Type Connector Pin Configuration

R20UT2028EJ0100 Rev. 1.00 NS 8
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Veus
D-
D+
NC

GND

DB WIN|[—

Table 7: Pin Configuration of mini-B USB Connector CN501

For connection with the host machine, the RL78/I1A DC/DC LED Control Evaluation
Board can be plugged directly into an available USB port.

3.12 External Connectors J1 and J2

J1 to J2 are connectors for external user hardware. Standard 0.1’ pitch, 10-way double
row, straight headers are mounted to bring all I/Os for usage. Please read the User’s
Manual of the RL78/I1A device carefully to get information about the electrical
specification of the available I/O ports.

Y
-
-
.
-
-
-
-
-

-
-
-
-
-
-
-
]

Figure 5: External Connectors J1 and J2
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J1 | Signal Name RL78/11A Pin Name Comment
1 P20 P20/ANIO/AVREFP Connected to VDD
2 P03 P03/RXD1/CMP5P/ANI16
3 P02 P02/TXD1/ANI17
4 P120 P120/ANI19
5 P40 P40/TOOLO
6 RESET RESET
7 P124 P124/XT2/EXCLKS
8 P123 P123/XT1
9 P137 P137/INTPO
10 [P122 P122/X2/EXCLK
11 |P121 P121/X1
12 |REGC REGC
13 |VSS VSS
14 |vDD VDD
15 | P31 P31/T103/TO03/INTP4
16 |P77 P77/INTP11
17__|P76 P76/INTP10
18 | P61 P61/SDAAO
19 |P75 P75/INTP9
20 |- - No connection

Table 8: Connector J1

J2 | Signal name RL78/G13 Pin Name Comment
1 P21 P21/ANI1/AVREFM Connected to VSS
2 P22 P22/ANI2/CMPOP
3 P24 P24/AN14/CMP1P
4 P25 P25/ANI5S/CMP2P
5 P26 P26/ANI6/CMP3P
6 P27 P27/ANI7/CMP4P
7 P147 P147/CMPCOM/ANI18
8 P10 P10/SO00/TXDO/TKCO00/INTP20/SCLAO/(DALITxD4)

9 P11 P11/S100//RXD0O/TKCOO01/INTP21/SDAAO/(TI07)/(DALIRXDA4)/
(TxRx4)

10 [P12 P12/ _SCKO00/(TKCO03)

11 |P200 P200/TKBOOO/INTP22

12 |P201 P201/TKBOO1

13 [P202 P202/TKBO10/(INTP21)

14 | P203 P203/TKBO11/TKCO02/(INTP20)

15 | P204 P204/TKBO20/TKCO03

16 | P205 P205/TKBO21/TKCO04/DALITxD4

17 | P206 P206/TKCO05/DALIRXD4/TXRx4/INTP23

18 |P30 P30/INTP3/RTC1HZ

19 |P05 PO5/TI05/TO05

20 |- - No connection

Table 9: Connector J2

R20UT2028EJ0100 Rev. 1.00
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3.13 Low Power 32 KHz Resonator Y1
The RL78/I1A DC/DC LED Control Evaluation Board is fitted with an external 32 KHz
resonator (Y1) characterized specifically for the RL78 devices supplied by Seiko
Instruments Inc.

This is a specially designed low power resonator designed to support the very low power
consumption of the RL78 family.

3.14 RL78/I1A Memory Map

The RL78/11A memory layout is shown in the table below.

Free for user application
software

OxFFEFF Mirror
0xF2000 51.75KB
S OxF1FFF Data flash memory
= |LoxF1000 K8
8 | OXOFOFFF
g Access prohibited area
< | OxFO800

Free for user application
software

OXEFFFF

Access prohibited area
0x10000
Free for user application

Table 10: RL78/I11A Memory Map

R20UT2028EJ0100 Rev. 1.00 NS 11
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Chapter 4 Getting Started

The default setting of the RL78/I1A DC/DC LED Control Evaluation Board is set
for demonstration of LED constant current control and dimming control using on-
board variable resistors. The RL78/I1A DC/DC LED Control Evaluation Board
comes already flash programmed with the LED control sample program. Chapter
6 will take the user through the software installation procedure.

Initially the user will be required to install the drivers, all of the development tools

and the associated documentation that can be found on the Renesas Electronics
website.

Please note as the communication interface between the host computer and the
RL78/I1A DC/DC LED Control Evaluation Board is the USB port interface, the
hardware and software must be installed properly.

R20UT2028EJ0100 Rev. 1.00 NS 12
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Chapter 5 Hardware Installation

After unpacking the RL78/I1A DC/DC LED Control Evaluation Board, connect the
supplied USB cable to the board. The connection of the board to the Host PC
should be done in conjunction with 6.4 USB Driver Installation.

This driver must be installed before the user can use the debugger.

R20UT2028EJ0100 Rev. 1.00 NS 13
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Chapter 6 Software Installation

The RL78/I1A DC/DC LED Control Evaluation Board works with several software
demonstration packages:

o  CubeSuite+ Integrated Development Environment, it provides an
environment for developing microcontrollers from creation of pin lists to
code generation, build and debug all in one tool

o  WriteEZ5 Flash programming GUI software to allow Flash programming
of the RL78/I1A internal Flash memory

o Applilet EZ for HCD Controller to generate full CubeSuite+ projects (for
LED constant current and different dimming control interfaces)

The CubeSuite+ IDE, the WriteEZ5 Flash programming GUI and the Applilet EZ
for HCD Controller software tool must be installed on your PC. For detailed
installation hints, refer to the following sections and to the corresponding
documentation of the CubeSuite+ IDE and WriteEZ5.

6.1 CubeSuite+ IDE Installation

This program can be downloaded from the Renesas Electronics website and

installed on the host PC.
http://tool-support.renesas.com/eng/toolnews/download/exel/solution lighting.html

6.2 WriteEZ5 Flash Programming GUI Installation

This program can be downloaded from the Renesas Electronics website and

installed on the host PC.
http://tool-support.renesas.com/eng/toolnews/download/exel/solution lighting.html

6.3 Applilet EZ for HCD Controller Installation

This program can be downloaded from the Renesas Electronics website and

installed on the host PC.
http://tool-support.renesas.com/eng/toolnews/download/exel/solution lighting.html

R20UT2028EJ0100 Rev. 1.00 NS 14
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6.4 USB Driver Installation
In order to use the RL78/I1A DC/DC LED Control Evaluation Board in
combination with CubeSuite+ IDE or the WriteEZ5 Flash programming GUI
software, “Renesas Electronics Starter Kit Virtual UART” USB driver must be
installed on the host machine.
Please follow according to version of Windows OS. Check your Windows version,
and follow the instructions:
Installation on Windows XP > 6.4.1
Installation on Windows Vista - 6.4.2
Installation on Windows 7 2643
Note Please download the USB driver from the Renesas Electronics website and
proceed with the installation using the following guidelines.
http://tool-support.renesas.com/eng/toolnews/download/exel/solution lighting.html
After the installation, go to 6.4.4 Confirmation of USB Driver Installation.
6.4.1 Installation on Windows XP
<1> When the RL78/I1A DC/DC LED Control Evaluation Board is connected to the
host machine, the board is recognized by “Plug and Play”, and the wizard for
finding new hardware is started.
Select “No, not this time” and click [ Next >].
Found New Hardware Wizard
Welcome to the Found New
Hardware Wizard
Windows will search for cument and updated software by
looking on your computer, on the hardware installation CD, or on
the Windows Update Web site {(with your pemission).
Read our privacy policy
Can Windows connect to Windows Update to search for
software?
) Yes, this time only
{71 Yes, now and every time | connect a device
{#) Mo, not this time
Click Mext to cortinue.
[ Net> || Cancel
Figure 6: Found New Hardware Wizard (Windows XP)
R20UT2028EJ0100 Rev. 1.00 RENESAS 15
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Select “Install from a list or a specific location (Advanced)” and click [Next >|.

Found Mew Hardware Wizard

This wizard helps you install software for:
USE Device

\_-) if your hardware came with an installation CD
B2 or floppy disk. insert it now.

Whiat do you want the wizard to do?

() Install the software automatically (Recommended)
(#) Install from a list or specific location (Advanced)

Click Mext to continue.

[ <Back || Ned> | [ Cancel

Figure 7: Install from a Specific Location (Windows XP)

<2> Mark “Include this location in the search” and then browse the computer to select
the directory where the USB driver has been copied.

Click [Next > .

Found New Hardware Wizard

Please choose your search and installation options. :g

(%) Search for the best driver in these locations.

lUze the check boxes below to limit or expand the default search, which includes local
paths and removable media. The best driver found will be installed.

[] Search removable media floppy. CO-ROM..)
Include this location in the search:

[ Files'Renesas\RPE\RL78G 13\USB Drivers\win ko]
(") Dont search. | will choose the driver to install.

Choose thiz option to select the device driver from a list. Windows does not guarantee that
the driver you choose will be the best match for your hardware.

[ <Back || Net> | [ Cancel

Figure 8: Search Location Specification (Windows XP)
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<3> Click | Continue Anyway | to continue the installation.

Hardware Installation

L | "_., The software you are inztalling far this hardware;
L

FRenezaz Starter Kt Wirkual LART

has not paszed Windows Logo testing to venfy itz compatibility
with Windows =P, [Tell me why thiz testing is important. |

Continuing your installation of thiz software may impair
or destabilize the commect operation of your zystem
either immediately or in the future. Microzoft strongly
recommends that you stop thiz installation now and
contact the hardware vendor for software that has
pazsed Windows Logo teshing.

[ Continue Arnpway ] I STOF Installation

Figure 9: Installation Confirmation (Windows XP)

<4> Click to close the installation wizard.

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard haz finished instaling the software for:

(3 Reneszas Starter Kit Virtual UART

Click Finish ta close the wizard.

Figure 10: USB Driver Installation Completion (Windows XP)
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6.4.2 Installation on Windows Vista

<1> When the RL78/I1A DC/DC LED Control Evaluation Board is connected to the
host machine for the first time, the board is recognized by “Plug and Play” and
the “Found New Hardware” window will pop up.

Select “Locate and install driver software (recommended)”.

Windows needs to install driver software for your Unknown
Device

@ Locate and install driver software {recommended)
Windows will guide you through the process of installing driver software
for your device.

% Ask me again later
Windows will ask again the next time you plug in your device or log on.

¥ Don't show this message again for this device
Your device will not function until you install driver software.

Figure 11: Found New Hardware Wizard (Windows Vista)

Then select “Browse my computer for driver software (advanced)” on the next
window.

Windows couldn't find driver software for your device

= Check for a solution
Windows will check to see if there are steps you can take to get your device
working.

% Browse my computer for driver software (advanced)
Locate and install driver software manually.

Figure 12: Install from a Specific Location (Windows Vista)

R20UT2028EJ0100 Rev. 1.00 NS 18
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<2> Select the folder where the USB driver has been copied on the host computer.

Please be careful, there are different USB drivers available for 32-bit Operating
Systems and 64-bit Operating Systems.

Click [Next > .

Browse for driver software on your computer

Search for driver software in this location:

C:\Program Files\Renesas\RPB\RLTEGI3\USE Drivers\winZk|

Include subfolders

Figure 13: Search Location Specification (Windows Vista)

<3> Click when the driver has been found..

(1] Windows Security
Would you like to install this device software?

Mame: Renesas Electronics Corporation Ports (C...
- Publisher: Renesas Electronics Corporation

Always trust software from "Renesas Electronics Install ] [ Don't Install I
Corporation”.

@ You should only install driver software from publishers you trust. How can [ decide which device
software is safe to install?

Figure 14: Installation Confirmation (Windows Vista)
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<4> Click to close the installation wizard.

The software for this device has been successfully installed
Windows has finished installing the driver software for this device:

Renesas Starter Kit Virtual UART

Figure 15: USB Driver Installation Completion (Windows Vista)

6.4.3 Installation on Windows 7

<1> When the RL78/I1A DC/DC LED Control Evaluation Board is connected to the
host machine, the board is recognized as an “Unknown Device” in the Device
Manager. Right click on the “Unknown Device” and select “Update Driver
Software...” within the Device Manager window.

Select “Browse my computer for driver software”.

L\-) U Update Driver Software - Unknown Device

How do you want to search for driver software?

< Search automatically for updated driver software
Windows will search your computer and the Internet for the latest driver software
for your device, unless you've disabled this feature in your device installation
settings.

< Browse my computer for driver software
Locate and install driver software manually.

Figure 16: Update Driver Software (Windows 7)
R20UT2028EJ0100 Rev. 1.00 RENESAS 20
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<2> Select the folder where the USB driver has been copied on the host computer.

Please be careful, there are different USB drivers available for 32-bit Operating
Systems and 64-bit Operating Systems.

Click [Next > .

@ I Update Driver Software - Renesas Starter Kit Virtual UART (COME)

Browse for driver software on your computer

Search for driver software in this location:

[@Include subfolders

2 Let me pick from a list of device drivers on my computer
This list will show installed driver software compatible with the device, and all driver
software in the same category as the device,

i MNext I Cancel

"

Figure 17: Search Location Specification (Windows 7)

<3> Click|Install | when the driver has been found..

- B
[+7] Windows Security ﬁ

Would you like to install this device software?

Marrne: Renesas Electronics Corporation Ports (T,
= 2 Publisher: Fenesas Electranics Corporation

[C] Always trust software from "Renesas Electronics Install ] [ Don't Install ]
Corporation”,

@ You should only install driver software from publishers you trust, How can [ decide which device
software is safe to install?

e

Figure 18: Installation Confirmation (Windows 7)

R20UT2028EJ0100 Rev. 1.00 NS 21
March 23, 2012 RENES



RL78/11A Chapter 6 Software Installation

<4> Click to close the installation wizard.

K,J [ Update Driver Software - Renesas Starter Kit Virtual UART (COMS)

Windows has successfully updated your driver software
Windows has finished installing the driver software for this device:

Renesas Starter KitWirtual UART

—
Figure 19: USB Driver Installation Completion (Windows 7)
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6.4.4 Confirmation of USB Driver Installation

After installing the USB driver, check that the driver has been installed correctly,
according to the procedure below.

Open "Device Manager" by entering:
[Start] = [Settings] = [Control Panel] - [System] - tab [Hardware]

When the RL78/I1A DC/DC LED Control Evaluation Board is connected to the
host PC, the "Renesas Electronics Starter Kit Virtual UART" (without "?" mark)
should be present under the section "Ports (COM & LPT)".

The screen above shows that the COM port number is "COM23".

When you change the USB port connection, the COM port number will be
changed as well.

£ Device Manager

File  Action wiew Help

M HE @0 & =1ma

+h DYDYCD-ROM drives -
+|-{idg Human Interface Devices
+-i=2) IDE ATASATAPT controllers
&g IEEE 1394 Bus host conkrollers
IE] Infrared devices
‘i Kevboards
'J Mice and other pointing devices
L Moderns
§ Manitars
B8 Mebwork adapters
B PCMCIA adapters
[a PCMCIA and Flash memory devices
= Parts (COM & LPT)
r;," Bluetooth Communications Pork {COMLS)
r;," Bluetooth Communications Pork {COMLG)
r;," ommunications Port {COM1)
o ECP Printer Paort {LPT1)
r;," Renesas Starter Kit Wirtual UART {COM23) —
+ ﬂ Processors
+ % 551 and RAID controllers
+- M Secure Digital host controllers v

o O O g O e Y o O

Figure 20: Device Manager

Caution Do not do “Hardware Modification Scan” when you communicate with the target
device.
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Chapter 7

Hardware
Configuration of
RL78/11A DC/DC

LED Control
Evaluation Board

Software
Configuration of
WriteEZ5 GUI

<1> Installing the
WriteEZ5 GUI

<2> Installing the
driver

<3> Installing the
parameter files

<4> Setting and
connecting

Table 11:

How to Use WriteEZ5 Flash Programming
Software

This chapter explains the basic operations of the WriteEZ5 GUI for programming
the RL78/I1A DC/DC LED Control Evaluation Board. This chapter covers how to
start the system, execute the EPV command (Erase, Program, Verify), and
program the target RL78/I1A device.

The conditions of the series of operations described in this chapter are as
follows:

Board: RL78/11A DC/DC LED Control Evaluation Board
CPU: RL78/I11A

Target Device: R5F107DE

Voltage level: 5V

Parameter file: R5F107DE.pr5

Clock setting: Internal-OSC

Port: COMxx (115200bps)
Operation mode: Chip

Write HEX file: *.hex

Option Setting: Blank check before Erase

Install the WriteEZ5 GUI software on the host machine you are using, by referring
to Chapter 6 Software Installation (if the software has not been installed yet).

Install the USB driver on the host machine you are using, by referring to Chapter
6 Software Installation (if the driver has not been installed yet).

The parameter files for the RL78/11A device can be found on the Renesas
Electronics website and then installed on the host computer.
http://tool-support.renesas.com/eng/toolnews/download/exel/solution lighting.html

Set the RL78/I11A DC/DC LED Control Evaluation Board by configuring switch
SW2 as following:

OFF
OFF
ON
OFF
ON
OFF
ON
OFF

N[N |WIN|—

SW2, Configuration for Flash Programming Mode

R20UT2028EJ0100 Rev. 1.00
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Figure 21: SW2 for Mode Configuration

Connect the RL78/I11A DC/DC LED Control Evaluation Board with the host
machine.

<5> Starting Start the WriteEZ5 GUI from the start menu:
[Start] = [All Programs] = [Renesas Electronics Tools] > [WriteEZ5]

Or use the shortcut icon on your Desktop.

B WriteEZ5
File Device View Help

2

-Device |
Mame :
Yersion :

T Farameter file -
Narne :
Wersion :

T — Load file
Mame
Date:
Chiksuimn :
Area:

- Connection to device-
Fart :
Speed

Fange
Freg. :

[ oM [

Figure 22: WriteEZ5 Start-up Screen

<6> Setting the (6.1) Select [Device] - [Setup] from the menu bar or click on the [Setup] icon.

programming - g «standard” tab of the “Device Setup” dialog box is opened:
environment

R20UT2028EJ0100 Rev. 1.00 NS 25
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B Device Setup

Standard ] Advance 1

Parameter fils " | PRM File Read

Host connection 1 Supply oscillator

Port i Frequency I [
Speed - Multiphy rate

-Operation Mode -
(" Chir

C Black Start ] ” ] Start J Y ]
(" Brea End . End ’

- Voltage settings -
Vdd [W]

[~ Target Reset Message

QK Cancel

Figure 23: Standard Device Setup Dialog Box

(6.2) Click on | PRM File Read | to open the parameter file selection window.

Select the directory where the parameter files have been installed.
Select the parameter file “R5F107DE.pr5”, and then click [Open |

Lookin: | 5 REF1076C =] 5 E
L [EIRSFI07ACpIS
@ [ R5F1074E prs
. [ER5FI07DEprS
MyRecent  [HpsF1076C prs
Documents

Desktop
r \: 29
My Documents

9

Ity Cormputer
.‘ . File name: ﬂ Open
[ Net\;\rurk Files of type: |ParameterFiIes(".prS;*.prm;*.prr) ﬂ Cancel
Figure 24: Parameter File Selection
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(6.3) From the “Port” list box, select the communication port that matches the
host machine being used. Select the communication speed of the host
connection.

=L55 Device Setup

Standard l Advance

Farameterfile  |R5F107DE. pr5 FEM File Fead

Host connectian Supply oscillator

Port | TESINTH Frequency
Speed Multiply rate

Operation Mode

[ [v

Start Start
(" Block
(‘" End End

[ M

@ Chip

“aoltage settings
Ydd [v] (500

| Target ResetMessage

(0]4 Cancel

Figure 25: Port Selection

Remark Selectable ports can be checked using Device Manager. For details, refer to
6.4.4 Confirmation of USB Driver Installation.

(6.4) Switch to the “Advance” dialog box:
In “Command Options”, check “Blank check before Erase”.

In “Security flag settings”, all the different options should remain unchecked.
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Device Setup

Standard Advance

Command options
[v Blank check befare Erase I

[ Readwverify after Frogram
[ Security flag after Program

[ Checksum after Pragram

Security flag settings

N [ouoooooo
[ Disable Block Erase Boot block end |003 i
[ Disahle Frogram FS Block start (000 =
[ FSBlockend 063 -
[ Disshle Boot block clustat reprogramming [ ShowAddress

D Code setftings

| TargetResethessage

0K, | Cancel

Figure 26: Advance Device Setup Dialog Box

(6.5) Click on the button [OK . The GUI software sets the parameters.

When the settings have bee completed, the following screen is displayed:

B writeEZ5 :| |E| @

File Device Wiew Help

P& 'R

4

b> FlashOpenning... Device B
Flash Open Ok Nam_e :
>>COMMAMND: Device Setup Wersion :

PRM File Read OK.

Fararmeter file
Mame REF10YDE
“arsion W1.00

Load file
Mame
Date :
Chksurm :
Ared

Connection to dewvice

Port: Com

Speed: 115200bps

Range: Chip

Freqg.:  Intermal0SC —

Multiphy : 1.00
~

Ready
Figure 27: Completion of Parameter Settings
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<7> Selecting a user (7.1) Select [File] > [Load] from the menu bar or click on the [Load] icon.
program

(7.2) Select a program file to be written to the target device, then click on the

button [Open|.

=5 WriteEZ5

File Device View Help

AT A Y4

»» FlashOpenning.... Device
Flash Open OK Namle :
> ParameterFile Reading.... Yersion :

Parameter file
M arme : REF100LE
Wersion : 1.00

Load file
Mame  YRPBRLYSGII STICK,
Date:  2011/02/21 12:32:56
Chicsum : 3245h
Area:  000000h-004128h

Connection to device
Port:  COMZ23
Speed  115200bps
Flange  Block 000-053+000-003
Freq. : Intenal-05C
Multiply - 1.00

Ready FIIM

Figure 28: Completion of HEX File Download

<8> Auto procedure Select [Device] > [Autoprocedure(EPV)] form the menu bar or click on the
(EPV) command [Autoprocedure] icon.
execution

When the [Autoprocedure(EPV)] command is executed, Blank Check — Erase —
Program and Flash Internal Verify are executed sequentially for the RL78/I11A
device.

B2 WriteEZ5

File Device Yiew Help

NP

7

block 000 to 003 Data blank check finish. Py Device
skip erase. Mame : REF100LE
Flash Programming Start... Wersion : 1.10

Flazh Programming <10%...
Flazh Programming <20%s...
Flazh Pragramming <307
Flazh Programming <407 ..
Flazh Programming <507 ...
Flazh Programming <B0%: ...
Flazh Programming <707
Flazh Programming <80%s...

Parameter file
Mame : REF100LE
Werzion : %1.00

Flazh Programming <907 ... Laad file
Code Flash Programnaing finizhl Mame YRPERLVSG13 STICK,
Flazh Programming Start... Date:  2011/02/21 123256
Flazh Programming <107 Chkzum : 3245k
Flazh Programming <207 ... Area:  000000DKh-004126R
Flazh Programming <307
Flash Programming <40%%... Cramresiionm i@ e
Flazh Programming <50%5... Pat:  COMZ3
Flash Programming <B0%:... Speed  115200bps
fles)h PIOETEmil 7 S, Range Elack DO0IB3+000-003
Flazh Programming <807 ... Freg : IntemalOSC
Flazh Programming <907 ... Multiph : 1.00
[ata Flagh Programming finish! “

I
Ready B

Figure 29: Completion of EPV Command
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<9> Terminating the Select [File] = [Quit] to terminate the GUI software. All settings executed are
GUI saved, so that those settings can be reused when the WriteEZ5 GUI is restarted.

<10> Execute Setthe RL78/I1A DC/DC LED Control Evaluation Board to the normal operation
application mode by applying the following settings.

OFF
OFF
OFF
OFF
OFF
OFF
ON
ON
Table 12: SW2, Configuration for Normal Operation Mode

O IN (OO WIN|—~

<11> Restarting the When the WriteEZ5 GUI is restarted, the latest settings should be applied.
GUI
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Chapter 8 Applilet EZ for HCD Controller

Applilet EZ for HCD Controller is a software tool used to automatically generate
software code for the RL78/11A microcontroller (and also for the 78K0/1x2), which
is used to control the LED current.

Software can be easily generated by specifying the setting and operation of the
RL78/I1A on the GUI. The generated software can be directly written into the
flash memory of the RL78/I1A microcontroller via a USB cable and the operation
can be performed and checked by using the RL78//1A DC/DC LED Control
Evaluation Board.

By using Applilet EZ for HCD Controller, a digital RL78/11A-based lighting system
can be designed without requiring a detailed knowledge of complex programming
languages. Furthermore, microcontroller software development, which can
usually take a certain amount of time, and operation evaluation can be
significantly reduced.

For further information please refer to the “Applilet EZ for HCD Controller User’'s
Manual” which can be found on the Renesas website.

8.1 General Settings

This section will go through the different Applilet EZ for HCD Controller’s general
settings.

<1> Open Applilet EZ for HCD Controller.

* Untitled - Applilet EZ for HCD Controller

Ele Project Buld Setting Help
d

Mew  Open

Target Dimmer Prograrm
Board

CRU

UARTx _‘I

CSl

Compiler 3

Figure 30: Applilet EZ for HCD Controller Main Window
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<2> Under the Project menu all of the MCU settings will be listed for configuration,
select CPU or simply press the “New” button.

* Untitled - Applilet EZ for HCO

[l

Figure 31: Applilet EZ for HCD Controller New Project

<3> Inthe CPU settings, select Target to EZ-0012 board.

Board Property

X

Target [Ez-012
Device: |R5F1 07DE w | [ ]Enakle 'On Chip Debug'.
Clock Source: |Internal osc. v |
Eraquency (MHz): |32 V|
Color: Limit (ma):
Channel1: [#]Enable | ~ [ ] Al Channel Synchraonized.
Ehannal Sl - w | [ Logarithmic dimming cantoral.

Chennel 3. [V]Enable [] "l

Channel 4: Enable

| ok || ocance

Figure 32: Applilet EZ for HCD Controller CPU Settings

<4> The Applilet EZ tool is able to generate code and projects for different compilers,
one of them is the new CubeSuite+ compiler. Select it by clicking on the Setting
menu, then Select Compiler and choose the CubeSuite+ compiler.

. Untitled - Applilet EZ for HCD Controller

File Project  Buid
D D"" . ) ¥| v CubeSuite+
Mew Open Sawe Compier Folder...
CCyeKko
Target FLASH Program...
= p C7 nnt1o PrOJECt Folder... P b 4
Figure 33: Applilet EZ for HCD Controller Compiler Selection
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Note

<5>

Make sure that you have installed the selected compiler correctly to your host PC
before building the project.

It is also possible to configure the output project folders by clicking on the Setting
menu and then selecting Project Folder.

These locations will specify the output paths of the generated files. Enter in your
desired destination but please keep in mind that Applilet EZ will then create
subdirectories under this folder for each Applilet EZ project. Click OK.

Project Folder §|

Sawve to:

ants and Settings\ablBB43 My DocumentshApplilet EZ HCD"-,Save| D

Project:
5 and Settingshab0664 3440y Documents\Applilet EZ HCD"-,PrDje:ts| D

| ok || camceL |

Figure 34:

8.2

<2>

Figure 35:

<3>

Applilet EZ for HCD Controller Project Folder

Fix Dimmer Program
This program sets a fixed duty value for each of the 3 LED channels. Make sure

that all settings explained previously are still correctly set before proceeding with
the following steps.

Make sure “Fix Duty” is still selected as the dimmer program.
Input “128” to all the channels so they are not too bright.

Dimmer Program

(®) Eix Duty

Chi: Che: Cha: I

Duty parameter available 0-255
Select Color: -|'

Applilet EZ for HCD Controller Fix Duty Settings

We can then save the new Applilet EZ project (.hcd file). Select the File menu,
then click on Save As... or simply click on the “Save” button, and input “fix.hcd
for example. To finish click Save.
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Save As E

Sawve in: |@ Save W ‘ Q2 e
Fiename: fiched | zewe |
Save as type: ‘Pruject Files (*.hcd) A ‘ [ Cancel I

Figure 36: Applilet EZ for HCD Controller Save As Window

<4> Please make sure to set the SW2 dip switch to the flash programming mode.
Then plug the power cable to the RL78/I11A DC/DC LED Control Evaluation
Board, and plug the USB connector. Click the “All P.“ button.

Al P.

Figure 37: Applilet EZ for HCD Controller All Program Button

<5> You will be informed about the progress of the compilation.

Build g|

?breaté'i'he pr'o-ject'f-o'ider.
Generate C code.

éStart Compilation.
lUsing CubaSuita+
HE*Hile “fix.hex" was created.

CLOSE

Figure 38: Applilet EZ for HCD Controller Compilation Progress
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<6> Next click OK when prompt to start flash programming.

AppEzHCD X

i ) Start FLASH programming.

(8]14 | Cancel |

Figure 39: Applilet EZ for HCD Controller Start Flash Programming

<7> During the flash programming procedure you will be informed about the actual
status of the programming.

Build X

Flash Erasing..

Data flash erase finish.
Flash Frogramming Start...
Flash Programming €10%2> ..
Flash Programming <20%6> ...
Flash Programming <30%6> ..
Flash Programming <40%2> ..
Flash Programming <60%>...
Flash Programming <B0%>...
Flash Programming <70%>...
Flash Programming <80%>..
Flash Pragramming €90%>..
(Code flash Programming finish!
Flash Programming Start...
Flash Programming <10%6>
Flash Programming <20%6>
Flash Programming €30%>..
Flash Programming €40%> .
Flash Programming <50%>..
Flash Programming <B0%>..
Flash Programming <70%> ..
Flash Programming <B0%> ..
Flash Programming <30%> ..
Data flash Frogramming finish!

| -

v
STOP CLOSE

Figure 40: Applilet EZ for HCD Controller Flash Programming Status

<8> Click CLOSE to exit the “Build” window. Remove the USB cable and the power
supply cable, and change the SW2 dip switch positions to the normal operation
mode. Plug the power supply cable to the board connector again and you should
see the LEDs light up according to the duty values set earlier.

LED channel 1 = Red
LED channel 2 = Green
LED channel 3 = Blue
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8.3 Variable Dimmer Program
This program sets the duty value for each channel according to a drawing pattern
data.
<1> Make sure that you have set all the settings as explained in the 8.1 General
Settings section.
<2> Save the new Applilet EZ project (.hcd file). Select the File menu, then click on
Save As... or simply click on the “Save” button, and input “variable.hcd” for
example. To finish click Save.
Save As g
Save in: ‘@ Dane A ‘ ¢ 35 S g
[ fix.bed
File name: |variab|e.hc:d | [ Save l
Sawve as type: |Pr0je|:t Files (*hecd) A | [ Cancel I
Figure 41: Applilet EZ for HCD Controller Save As Window
<3> We now have a new Applilet EZ project file and we will change the dimmer
program to Variable.
Figure 42: Applilet EZ for HCD Controller Dimmer Program Selection (Variable)
<4> Click on the “Edit” button under “Variable” and the “Dimmer Programming”
window will open. Enable the “Cyclic” check box. Click the “Ch.1* button to
select this channel for modification. Select the line mode as shown below. This
will allow you to draw the PWM duty cycle versus time by using your mouse
pointer.
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B

Chi:
Ch.2:
Ch.3:
Ch4:

Edit

E

CSY

0 30

Total
60000 | mz

Speed Step
10 | X 10 msfstep X | 600 | =

60
[sec]

Cyclic l

ok || canceL

Figure 43: Applilet EZ for HCD Controller Dimmer Programming (Variable)

<5> Draw something close to the sinusoidal wave below and then click OK.

-

Edit

Ch.1:
Ch.2:
Ch.3:
Ch4:

s‘/w

B

Csy ‘

B

0 30

Total
60000 | ms

Speed Step
10X 10 msfstep ¥ | 600 | =

Cyelic [

60
[=ec]

oK ] I CANCEL

Figure 44: Applilet EZ for HCD Controller Wave Editor (1 channel)
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<6> Repeat the same process for the two other channels. Then click on the OK
button to exit the variable dimmer control window.

DIMMER PROGRAMMING g

Mode Edit

0 30 60
[sec]

Speed Step Total
10|% 10 ms/fstep ¥ | 600 | = €0000 | ms ] Cyelic [

oK l l CANCEL

Figure 45: Applilet EZ for HCD Controller Wave Editor (3 channels)

<7> Make sure that SW2 dip switch of the RL78/I1A DC/DC LED Control Evaluation
Board is in flash programming mode, and that the USB and power supply cables
are connected correctly. Click the “Save” button and then the “All P.” button.
After downloading the application, please disconnect the USB and power supply
cables and set the board to the normal operation mode.

<8> Plug again the DC 5V power supply, and you should now see the on-board LEDs
running the variable dimming application based on the above wave form.
8.4 Analog Input Dimmer Program

This program sets the duty value for each channel according to the on-board
variable resistors values read from the A/D converter.

<1> Make sure that you have set all the settings as explained in the 8.1 General
Settings section.
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<2> Save the new Applilet EZ project (.hcd file). Select the File menu, then click on
Save As... or simply click on the “Save” button, and input “analog.hcd” for
example. To finish click Save.

<3> We now have a new Applilet EZ project file and we will change the dimmer
program to Analog Input.

use: |each channgl % moving average: | 1 v
Figure 46: Applilet EZ for HCD Controller Dimmer Program Selection (Analog)

<4> Make sure that SW2 dip switch of the RL78/I1TA DC/DC LED Control Evaluation
Board is in flash programming mode, and that the USB and power supply cables
are connected correctly. Click the “Save” button and then the “All P.” button.
After downloading the application, please disconnect the USB and power supply
cables and set the board to the normal operation mode.

<5> Plug again the DC 5V power supply, and you should now see the on-board LED
brightness changing according to the actions applied to the variable resistors
(VR1, VR2 and VR3).

8.5 DMX512 Dimmer Program

This sample shows how to set up Applilet EZ to program the DM512 stack into
the R5F107DEG assembled to the RL78/I1A DC/DC LED Control Evaluation
Board.

<1> Make sure that you have set all the settings as explained in the 8.1 General
Settings section.

<2> Save the new Applilet EZ project (.hcd file). Select the File menu, then click on
Save As... or simply click on the “Save” button, and input “dmx512.hcd” for
example. To finish click Save.

<3> We now have a new Applilet EZ project file and we will change the dimmer
program to DMX512.

(@) D512

Figure 47: Applilet EZ for HCD Controller Dimmer Program Selection (DMX512)
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<4>

Figure 48:

<5>

<6>

Figure 49:

Open the “DMX512 Property” dialogue box by selecting the Project menu and
clicking on DMX512... or simply by clicking on the “Setting” button. Check that
the settings are as shown below.

DMX512 Property R|

Channel 1 Channel 2 Channel 3 Channel 4

Slot: Slot: Slot: I:I

[ ]Enahle DX Status Slat, Slot awvailable 1-512.

[ ]

ok ][ canceL

Applilet EZ for HCD Controller DMX512 Property Dialogue Box

Make sure that SW2 dip switch of the RL78/I1A DC/DC LED Control Evaluation
Board is in flash programming mode, and that the USB and power supply cables
are connected correctly. Click the “Save” button and then the “All P.” button.
After downloading the application, please disconnect the USB and power supply
cables and set the board to the normal operation mode.

You should now be able to control the LEDs on the RL78//1A DC/DC LED
Control Evaluation Board via the DMX512 protocol by connecting a DMX512
master device. For example, Renesas Electronics offers the Lighting
Communication Master Evaluation Board (EZ-0008). This board can be used as
a communication master device supporting DMX512, DALI and IR
communications.

The RL78/I11A DC/DC LED Control Evaluation Board can be controlled by this
Lighting Communication Master Evaluation Board together with a GUI running on
the host PC. There is a GUI for DMX512 control and a GUI for DALI control, both
GUIs can be downloaded from the Renesas Electronics website.

Power supply (5V, =1A)

Host PC

RL78/11A DC/DC LED Control
Evaluation Board (EZ-0012)

Lighting Communication Board (EZ-0008)

System Configuration for DMX512 Control
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<7> On the Lighting Communication Master Evaluation Board, please confirm that
SW4 is set to “RUN" and SW3 is set to “DMX”.

<8> Connect the Lighting Communication Master Evaluation Board (EZ-0008), via the
DMX connector J1, with the RL78/I1A DC/DC LED Control Evaluation Board
(acting as a DMX512 slave board), via the DMX connector CN3, using the three
wires provided.

<9> Connect the Lighting Communication Master Evaluation Board to the host PC
using a USB cable.

<10> Plug the DC 5V power supply cable to the RL78/I1TA DC/DC LED Control
Evaluation Board via connector CN1.

<11> Send DMX512 commands to the RL78/I1TA DC/DC LED Control Evaluation Board
using the DMX512 Master Controller GUI.

Note To find details about the DMX512 Master Controller GUI, please refer to the
corresponding User’s Manual (U19596EJ1V0OUMOO0) that can be downloaded
from the Renesas Electronics website.

8.6 DALI Dimmer Program

This sample shows how to set up Applilet EZ to program the DALI (Digital
Addressable Lighting Interface) stack into the R5SF107DEG assembled to the
RL78/11A DC/DC LED Control Evaluation Board.

<1> Make sure that you have set all the settings as explained in the 8.1 General
Settings section.

<2> Save the new Applilet EZ project (.hcd file). Select the File menu, then click on
Save As... or simply click on the “Save” button, and input “dali.hcd” for example.
To finish click Save.

<3> We now have a new Applilet EZ project file and we will change the dimmer
program to DALI.

(@) DAL

Figure 50: Applilet EZ for HCD Controller Dimmer Program Selection (DALI)
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<4> Open the “DALI Property” dialogue box by selecting the Project menu and
clicking on DALL... or simply by clicking on the “Setting” button. Choose the
appropriate settings for your evaluation.

DALI Property g|

Channel1 ‘Channe\E Channel 3

“Yarsion Group

Short Address [JGroupd  [[]Group8

Randam 167772)  [Groupt  [JGroup3
DGroup 2 DGroup 10

e [Growga [ Group 11

EeperEnlCevel D Group 4 D Group 12

System Failure Level: D Group D Group 13

Max, Level 254 [Groupt  []Group 14
[Growg? [ |Group 18

Mdin.

Fade

EEE

Fade

Lok ][ ocawcel |

Figure 51: Applilet EZ for HCD Controller DALI Property Dialogue Box

<5> Make sure that SW2 dip switch of the RL78/I1A DC/DC LED Control Evaluation
Board is in flash programming mode, and that the USB and power supply cables
are connected correctly. Click the “Save” button and then the “All P.” button.
After downloading the application, please disconnect the USB and power supply
cables and set the board to the normal operation mode.

You should now be able to control the LEDs on the RL78//1A DC/DC LED
Control Evaluation Board via the DALI protocol by connecting a DALI master
device. For example, Renesas Electronics offers the Lighting Communication
Master Evaluation Board (EZ-0008). This board can be used as a communication
master device supporting DMX512, DALI and IR communications.

<6> The RL78/I1A DC/DC LED Control Evaluation Board can be controlled by this
Lighting Communication Master Evaluation Board together with a GUI running on
the host PC. There is a GUI for DMX512 control and a GUI for DALI control, both
GUIs can be downloaded from the Renesas Electronics website.

Lighting Communication Power supply (5V, 2A)
Board (EZ-0008)

RL78/11A DC/DC LED Control
Evaluation Board

Figure 52: System Configuration for DALI Control
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<7> On the Lighting Communication Master Evaluation Board, please confirm that
SW4 is set to “RUN*.

<8> Connect the Lighting Communication Master Evaluation Board (EZ-0008), via the
DALI connector J4, with the RL78/I1A DC/DC LED Control Evaluation Board
(acting as a DALI slave board), via the DALI connector CN2, using the two wires
provided.

<9> Connect the Lighting Communication Master Evaluation Board to the host PC
using a USB cable.

<10> Plug the DC 5V power supply cable to the RL78/I1TA DC/DC LED Control
Evaluation Board via connector CN1.

<11> Send DALI commands to the RL78/I1A DC/DC LED Control Evaluation Board
using the DALI Master Controller GUI.

Note To find details about the DALI Master Controller GUI, please refer to the
corresponding User’s Manual (U19607EJ1V1UMOO0) that can be downloaded
from the Renesas Electronics website.

8.7 IR Remote Control Dimmer Program

This sample shows how to set up Applilet EZ to program the IR remote control
dimming program into the R5F107DEG assembled to the RL78/I11A DC/DC LED
Control Evaluation Board.

<1> Make sure that you have set all the settings as explained in the 8.1 General
Settings section.

<2> Save the new Applilet EZ project (.hcd file). Select the File menu, then click on
Save As... or simply click on the “Save” button, and input “ir.hed” for example.
To finish click Save.

<3> We now have a new Applilet EZ project file and we will change the dimmer
program to IR Remote Control. The “Custom Code” and “Data Code” can be
customized according to the user’s needs.

Custom Code; |0x0000 Data Code: |0xbA,

Figure 53: Applilet EZ for HCD Controller Dimmer Program Selection (IR)
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<4> Make sure that SW2 dip switch of the RL78/I1A DC/DC LED Control Evaluation
Board is in flash programming mode, and that the USB and power supply cables
are connected correctly. Click the “Save” button and then the “All P.” button.
After downloading the application, please disconnect the USB and power supply
cables and set the board to the normal operation mode.

<5> Plug again the DC 5V power supply, and you should now be able to control the
LEDs on the RL78/I1A DC/DC LED Control Evaluation Board via the IR remote
control protocol by using an IR transmitter device. For example, Renesas
Electronics offers the Lighting Communication Master Evaluation Board (EZ-
0008). This board can be used as a communication master device supporting
DMX512, DALI and IR communications.

e — : [ Power supply (5Y, =1A)

Host PC

RL78/11A DC/DC LED Control
Evaluation Board (EZ-0012)

Lighting Communication Board (EZ-0008)

Figure 54: System Configuration for IR Remote Control

<6> On the Lighting Communication Master Evaluation Board, please confirm that
SW4 is set to “RUN" and SW1 to the expected channel (the channel should be
the same as the one set in Applilet EZ for HCD).

The output code is based on NEC IR remote control protocol:
CH1: Send custom code 0x0000+data code Ox5AA5
CH2: Send custom code 0x0000+data code 0xDA25

<7> Place the IR transmitter (LED1) of the Lighting Communication Master Evaluation
Board in the line-of-sight of the IR receiver (U2) of the RL78/I1A DC/DC LED
Control Evaluation Board.

<8> Connect the Lighting Communication Master Evaluation Board to the host PC
using a USB cable.

<9> Plug the DC 5V power supply cable to the RL78/I1A DC/DC LED Control
Evaluation Board via connector CN1.

<10> Press switch SW2 of the Lighting Communication Master Evaluation Board to
send IR signals to the RL78/I1A DC/DC LED Control Evaluation Board.
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Chapter 9 Troubleshooting

¢ In driver installation, recognition based on Plug and Play is disabled.
Cause:

The USB connector may not be inserted normally into the USB port of the
personal computer.

Action:

Check that the USB connector is inserted fully into the USB port of the personal
computer.

Alternatively, disconnect the USB connector, and then insert the USB connector
again after a while.

e The driver file cannot be found at a specific location
Cause:

The WriteEZ5 programming software may not be installed correctly.
Action:

Install the WriteEZ5 software again by referring to Chapter 6 Software
Installation.

¢ In checking by Device Manager, "USB Serial Port"” or "USB High Speed
Serial Converter"” is not displayed. Alternatively, the "!" or "x" is
prefixed

Cause:

The USB connector may not be inserted normally into the USB port of the
personal computer.

Action:

Check that the USB connector is inserted fully into the USB port of the personal
computer.

Alternatively, disconnect the USB connector from the USB port, then insert the
USB connector again after a while.

Cause:
The driver may not be installed correctly.
Action:

<1> When this product is connected to the personal computer, right-click the

driver marked with "!" or "x

Click when displayed.

<2> On Device Manager, execute [Hardware Modification Scan].

<3> Install the driver again with Plug and Play.

Cause:

The device may not be recognized (in the case of connection with the USB hub).
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RL78/11A Chapter 9 Troubleshooting

Action:

Try the following:

o Disconnect the USB connector, then insert the USB connector again.
e Connect the USB connector to another port of the USB hub.

If the same symptom occurs, do not use the USB hub, but directly connect the
connector to the USB port of the personal computer.

e When this product is connected with a personal computer, the "Add
New Hardware Wizard" screen is displayed

Cause:

If the USB connector of this product is not inserted into the USB port used at the
installation time but into another USB port, this product may be recognized as a
new hardware item.

Action:

Install the driver by referring to Chapter 6 Software Installation.

¢ Communication with the RL78//1A DC/DC LED Control Evaluation Board
is disabled

Cause:
The driver may not be installed correctly.
Action:

Check if the USB driver is installed correctly by referring to Chapter 6 Software
Installation.

Cause:

The COM port selected via the “Port list box” within device setup menu of
WriteEZ5 may not be set correctly.

Action:

Set the port checked using Device Manager.

Cause:

The RL78/11A DC/DC LED Control Evaluation Board is operating in Virtual UART
mode.

Action:

Set the board to the On-Board Debugging / Flash Programming mode.

Cause:
The PRM file selected in [Device Setup] may be incorrect.
Action:

Use the corresponding PRM file that matches the target device. For information
about the PRM file, refer to Chapter 7 How to Use WriteEZ5 Flash
Programming Software.
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Figure 55: RL78/I11A DC/DC LED Control Evaluation Board Schematic
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Chapter 11 Bill of Materials
Item Reference Parts name Rating Type
1 C1,C2 Laminated ceramic capacitor |3.7 pF @ 50 V 1005
2 C3 Laminated ceramic capacitor |0.47 uF @ 25V 1608
3 C4,C5 Laminated ceramic capacitor | 0.1 uF @ 50 V 1608
4 C101-C103, C201-C203, C301-C303 Laminated ceramic capacitor |10 uF @ 16 V 2012
C104, C105, C204, C205, C304, C305,
5 C401, C403, C404, C501, C503, C509- |Laminated ceramic capacitor |0.1 uF @ 50 V 1608
C511

6 C402, C502, C512 Electrolytic capacitor 22 uF @50V DIP
7 C504 Laminated ceramic capacitor |0.01 uF @ 50 V 1608
8 C505, C506 Laminated ceramic capacitor |39 pF @ 50 V 1608
9 C507, C508 Laminated ceramic capacitor |0.47 uF @ 25V 1608
10 CN1 Power Supply Jacks EIAJ 2 DIP
11 CN2 Connector 2 poles DIP
12 CN3 Connector 3 poles DIP
13 CN501 USB connector Micro-USB (USB2.0) SMD
14

15 D101-D303, D201-D203, D301-D303 Schottky-barrier diode 30V,1A SMD
16 D401, D402, D501-D503 diode 80V,04A DIP
17 DB Bridge diode 600V, 0.5A SMD
18 J1,J2 DIP pin header 20p DIP
19 J3 SIP pin header 6p DIP
20 L1-L3 Inductance 150 uH, 400 mA SMD
21 LED101 High power LED Red SMD
22 LED201 High power LED Green SMD
23 LED301 High power LED Blue SMD
24 PC401, PC402 Photocoupler SMD
25 Q101, Q201, Q301, Q401 Transistor 60V,0.1A SC-59
26 Q102, Q202, Q302 Transistor array 20V,0.25A SMD
27 Q103, Q203, Q303 Power MOSFET 30V,4A TO-252
28 2;65121621%652%6222; ;322'1 5 |SMT resistor 10 k2, 0.125 W 2012
29 R2, R408, R511 SMT resistor 1kQ, 0.125 W 2012
30 R102, R104, R202, R204, R302, R304 | SMT resistor 2kQ, 0.125 W 2012
31 R103, R105, R203, R205, R303, R305 | SMT resistor 150 Q, 0.25 W 3216
32 R106, R206, R306 SMT resistor 47 Q,0.125 W 2012
33 R108, R208, R308 SMT resistor 1.3Q,05W 6331
34 R109, R209, R309 SMT resistor 200 Q,0.125 W 2012
35 R401 SMT resistor 1.2kQ, 0.125W 2012
36 R402 SMT resistor 330Q,0.125 W 2012
37 R403 SMT resistor 3.3kQ, 0.125 W 2012
38 R404 SMT resistor 4.7 Q,0.125 W 2012
39 R405 SMT resistor 11 kQ, 0.125 W 2012
40 R407 SMT resistor 120 Q, 0.125 W 2012

R20UT2028EJ0100 Rev. 1.00
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Item Reference Parts name Rating Type
41 R501, R505 SMT resistor 1.5kQ, 0.125W 2012
42 R502, R503 SMT resistor 27 Q,0.125 W 2012
43 R101, R210, R310, R507-R510, R515 SMT resistor 100 kQ, 0.125 W 2012
44 R514 SMT resistor 100 Q, 0.125 W 2012
45
46 SwWi1 Slide switch Black SMD
47 SW2 DIP switch 8 poles SMD
48 SW3 Slide switch 1 pole DIP
49 SW501 Push switch 1 pole SMD
50 u1 CPU 38 pins SMD
51 U2 RECEIVER IR REM CTRL DIP
52 U401 Interface IC SMD
53 us01 Interface IC SMD
54 U502 CPU 30 pins SMD
55 VR1-VR3 Slide volume 10 kQ SMD
56 Y1 Ceramic resonator 32.196 kHz SMD
57 Y501 Crystal units 16 MHz SMD
58 ZD401 Zener diode SMD

Table 13: Bill of Materials
R20UT2028EJ0100 Rev. 1.00 REN ESNS 50
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